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About This Presentation

Provides you with a brain dump of useful tips

Presentation is self-contained

» There is plenty to cover
» All the information you need to implement these tips is in this presentation

There are over 60 tips

» Although some “tip pages” have more than one tip!

If you have any trouble with a tip, email me at: pmooney@pmooney.net
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Where Did I Get These Tips?

From my life as a consultant ...

Forums

» www.notes.net
» www-142.ibm.com/software/sw-lotus/support

Blogs

» Just too many to mention!
» www.dominoblogs.com

Show 'n Tell Thursday

» Tips donated by bloggers
» All categorized and aggregated for convenience
= www.rhs.com/web/blog/gregate/v3test.nsf
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Tip #1: Naming Conventions

= Don't use spaces, dots, or ampersands (&) in server, domain, and
certifier names
» Causes issues in many areas, like SMTP
= Reply to all, with multiple addresses
= Internal addresses appear incorrect to Internet recipients
» Mail connector issues
= MS exchange mail connector does not work correctly in this scenario
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Tip #2: Managing Notes.ini Parameters

= To easily add, change, delete, and track NOTES.INI parameters, place them
in server configuration documents

Current parameters: ServerTasks=HTTF, Router, Replica,Stats,Adminp,&magr

Last parameter set: ServerTasks

Current value: HTTP, Router, Replica,Stats,Adminp.&mar

Parameter set by: Paul Moonewimooney at 17:28 Today

SetitModify Parameters

» Not just those listed In the dialog boX — add any that you WIS

» Great for maintaining standards for servers or server groups
= Assists in moving servers — custom parameters stay in the config document
= Parameters inherited immediately upon restart

» Note: Some third-party products don't like this feature!

m software
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Tip #3: Restarting Tasks

= Want to restart tasks that supposedly don't have a restart feature?

» Use the RESTART TASK command
= Example: restart task router
= Example: restart task adminp

tuspl :)
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Tip #4: Agent Manager Commands

= To see the schedule of agents to be run on the server
» Type “Tell amgr show schedule” on the console

= To force an agent to run from the console

» tell amgr run “database.nsf” 'agent name'
= Note: Both the double quotes and single quotes are required for this to work
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Tip #5: Extending Your Logs

= Default log keeping on LOG.NSF is sometimes too short
» I tend to recommend at least 14 days of logging

= Modify the NOTES.INI on the server

» LOG=LOG.NSF, 1, 0, 14, 40000
= "14” is the number of days LOG.NSF records data
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Tip #6: Setting Maximum Sessions

= Set the maximum number of sessions the Domino server will accept
before refusing requests

» Set Config Server_MaxSessions=n
» Default = no limits
= Useful to limit requests in the following scenarios:

» Resource-limited server
» Rogue agents opening many sessions
» Cluster scenario and balancing user load
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Tip #7/: Setting Maximum Users

= Set the maximum number of users the Domino server will accept
before refusing requests

» Set Config Server_MaxUsers=n

= This does not prevent server access

tuspl :)
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Tip #8: Restart Server Delay

= Restart server command defaults to a 10-second delay

= Sometimes this is too short

» Running additional tasks
= Sametime
= BlackBerry enterprise server

= Make it longer!

» SERVER_RESTART DELAY=n
= N = value in seconds
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Tip #9: Mail Configuration Updates

= Apply router configuration changes immediately
» Type “Tell router update configuration” on the console

= Get delivery stats from the router
» “Tell router delivery stats”
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Tip #10: Saving Mail File Space with Single-Copy

Database v mm 2 X

= Modify the template to become a

. Design is not hidd
single-copy template ——
. Allow design locking
= Run the design task b e
. Categories
» Updates mail databases’ property Show in ‘Open Database' dislog
from the templ ate Include in multi-database indexing

Do not mark modified documents as unread
Mark parent nate on reply or forward

= Run the compact task o

i

2 Saves a pprOX 1 0 M B per ma II fl Ie ¥ Inherit design from master template
Template name StdR7Mail

Template version is 7.0 (12/08/2005)

Refresh design on admin server only
v Database file is a master template
Template name dwa?
List as advanced template in 'New D atabase' dialog
Copy profile documents with design
v Single copy template

Multiingual database
Default language
Default region
Default sort order
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Tip #11: SMTP Port Forcing

= Using multiple network cards in a Domino server, you can force
SMTP traffic through a specific port to the appropriate card (or any
internet port other than HTTP)

» Allows splitting of traffic by port, i.e., NRPC vs. SMTP
» Useful in DMZ environment

= Map the IP address to the port using the SMTPNotesPort ini variable
as shown in the example below

Ports=TCPIP, TCPIPSMTP

TCPIP=TCP, 0, 15, 0
TCPIP_TCPIPAddress=0,10.12.51.1:1352
TCPIPSMTP=TCP, 0, 15, 0
TCPIPSMTP_TCPIPAddress=0, 207.41.72.20:1352
SMTPNotesPort=TCPIPSMTP

tusp s}
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Tip #12: Limiting the Availability of DWA Tabs

= Domino Web Access (DWA) interface loads all tabs by default
» Welcome Page, Mail, Calendar, To Do, Contacts, Notebook

= What if you want to limit the tabs?
» For instance, only have users see the Mail and Contacts tabs

= Starting in 7.0, the ini variable, iNotes_WA_Areas, allows enabling
and disabling of tabs

tuspl :)
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Tip #12: Limiting the Availability of DWA Tabs

* iNotes_WA_Areas=1,1,1,1,1,1

» Where 0 = disable and 1 = enable and the tabs are in order of Welcome Page,
Mail, Calendar, To Do, Contacts, Notebook

= Example: iNotes_ WA_Areas=011010
» Only Mail, Calendar, and Contacts are visible

Welcome, Paul Mooney X IM Disconnected

My Mail Inbox

& Inbox @ New v Reply ¥ Forward ¥ Move ¥ Follow Up ~
% Drafts | ke | | nata_
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Tip #13: DWA Performance — Reuse Windows

= To force DWA to reuse windows instead of opening up new browser
windows every time a link is clicked, use:

» iNotes_ WA_ReuseChildWindows=1

= This ini variable is available with the 6.5.3 performance fix and
above

tuspl :)
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Tip #14: DWA Performance — Use Cached Icons

= To improve DWA performance, create a Web Site Rule document to
prevent repeated retrieval of icons

Web Site Rule

Description: icons rule
Type of rule: HTTP response headers

Incoming URL pattern:  ficons/*
HTTP response codes: 200, 206
" Don't add header
Expires header. * Add header only if application did not

 Always add header (override application's header)

% Specify as number of days
" Specify as date

Expires after 364 days

Custom headers: Name: Value: [ Override
Name: Value: [ Ovemide
Name: Value: [ Override
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Tip #15: Troubleshooting HTTP Configuration

= Issue a Tell command at the server console
» Tell HTTP Dump Config

= Dumps HTTP configuration to HTTPCFG.txt in:
» x\Lotus\Domino\data\IBM_TECHNICAL_SUPPORT

= Excellent method of getting full configuration of HTTP stack and includes:

» Rules
» Port settings

= Don't forget “Tell HTTP refresh”
» Rereads HTTP config without restart

tuspl :)
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Tip #16: HTTP Logging — DOMLOG.NSF File Size

= DOMLOG.NSF records all GET and POST requests, so it can become very
large
= You can ignore certain requests

» All image requests
» All GET requests

» Requests from certain IP addresses URLs:
Methods:
= For example, to ignore GET requests: MIME types:

User agents:

1. Go to the server document

2. Then, Internet Protocols/HTTP tab
" Exclude from Iogging section Hosts and domains: J“192.168.’L|

» Requires HTTP refresh to take effect

Return codes:
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Tip #17: HTTP DOMLOG.NSF Cleanup

= Another way to decrease the size of the DOMLOG.NSF database is to
enable the cleanup Agent

= This purges data over 10 days old from the database

# Domino Web Server Log (7) ... X

T X
=

Domino Web Server Log (7) agCleanup agCleanup

L2 Viserver/0=mooneyidomlog.nsf - agH efreshView agFI efreshView
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Tip #17: HTTP DOMLOG.NSF Cleanup (cont.)

= If you wish to increase/decrease number of days
= Modify the document selection object in the agent

agCleanup | agCleanup {(Agent) : Document Selection

=l m agCleanup | agCleanup [&gent) Run
4 Document Selection

# Action date created is older than 10 davs
= Change the number of days :
and save the agent Add Conditon

¢ Condiion v

Search for documents whose...

Notes will find documents created or modified on the date or between the dates specified.
Choose the kind of date range [e.q.. on a specific date or between two dates) and then

m software select the date.
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Tip #18: Restricting the HTTP Upload Size

= Earlier versions of Domino had no limit on uploaded attachments
» Performance and stability issues occur if no limit is set

= As of Release 5.x, you can control the POST size
= Set the Maximum POST data field in the Server document

PMaximurm POST data (in 10000

kilobytes):

File compression on Disabled

» Note: If Intern upload:
document instead

Lotusphers. .
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Tip #19: HTTP and Internet Passwords

= HTTP password changes are cached on the server

= Can confuse users
» At some point, both their old and new passwords work!

= HTTP_PWD_CHANGE_CACHE_HOURS=0

» Set in the notes.ini file
» Prevents both passwords from functioning
» The moment the user changes his/her password, it is the only active password

tuspl :)
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Tip #20: HTTP Web Agents

= Agents initiated by an HTTP application are NOT managed by the
AMgr task

» They are managed by the HTTP task
» This is useful to know in order to debug major HTTP peaks

tuspl :)
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Tip #21: HTTP Web Agent Timeouts

* Troublesome HTTP Web Agents can hurt HTTP performance

» Reporting Agents are an example

» For example, if the user clicks a button that generates a large report over a
browser, this could affect the HTTP stack (consuming resources)

= Set HTTP Agents to timeout after x seconds

» Default is not set
» Poorly configured HTTP triggered agents could “hurt” your server

Runweb agents concurrently? "Enabled ;¥

Web agent timeout: "0 seconds
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Tip #22: Restricting Web Access

= The database property, “"Don’t allow URL open,” ensures a database
will not be opened from a Web client

» Restricts: http://Host/Database.nsf/* commands
= Sends 500 Not Authorized error

Database v == 7 X

Domino Web Server Log (7]
Server server/mooney
Filename domlog.nsf
Type Standard

Archive Settings... Encryption Settings...

Settings
Replication Settings...  Replication History...

¥ UseJavaScript when generating pages
Require S5L connection

Don't allow URL open

Disable background agents for this database
v Allow use of stored forms in this database
Display images after loading

m software Allow document locking
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Tip #23: Cluster Database Creation

= When creating new replicas of databases, or ensuring that replicas
exist, use the Admin client to create the replicas from the Files tab

» Right-click on the folder that contains the files to replicate and then choose New
- Replica(s)

= The request for replica creation of all databases in the folder is
submitted to ADMIN4.NSF

Folder...

Link...

Delete Folder... Replica(s)...

Catalol  Manage Directory ACL...

tusp s}
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Tip #24: Clustering Over Private Ports

= A typical clustering architecture has a private NIC between cluster
servers and a “public” NIC for user access over LAN/WAN

= Force cluster traffic through the private NIC

» Public switch will not be flooded with traffic from clrepl task
» Public NIC accepts user/server traffic — not flooded with cluster traffic

tuspl :)
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Tip #24: Clustering Over Private Ports (cont.)

= To force the cluster traffic through a private NIC:

1. Give each NIC an IP address
2. Create two ports in Domino server
= Admin client/server tab/ports option
3. Create two ports in the Server document
= Ports section/Notes network ports
4. Map the ports to the IP address
= portname_TCPIPADDRESS=0,192.168.1.1:1352
5. Map cluster traffic to the port
= SERVER_CLUSTER_DEFAULT_PORT=portname
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Tip #25: Cluster auxiliary port (ND8)

= What if the private NIC fails?

* You should have standard replication as a backup to cluster
replication anyway

» For a few reasons!

= Server_Cluster_Auxilary_Port="*
» Tells the cluster engine to failover to alternative port if default port is unavailable

tuspl :)
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Tip #26: Cluster Work Queues

= Cluster performance is dependent on the work queue depth

» Type “Sh stat replica” on the console
» Look for cluster work queue depth statistics

= Work queue depth is critical to cluster performance

Reblica.Cluster.woerueueDepth =9
Replica.Cluster.WorkQueueDepth.Avg
Replica.Cluster.WorkQueueDepth.Max

O®

MSoftware le uszoa
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Tip #27: Customizing Client Failover Errors

= When a server fails with a database open, a user gets this message, known
as Error 0807

IBM Lotus Notes

5 The server is not responding. The server may be down or yau may be experiencing network problems. Contact your
i ow

system administrator if this problem persisks.
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Tip #27: Customizing Client Failover Errors (cont.)

= You can change the error messages by adding these lines to your
NOTES.INI file

» Err_0807=Your e-mail server is no longer responding. However, you may be able
to switch to a backup server and continue working. To do this, you must close
your mail file and re-open it.

» Err_0AO02=Your e-mail server is no longer responding. However, you may be able
to switch to a backup server and continue working. To do this, you must close
your mail file and re-open it.

IBM Lotus Notes

/) Custom Error Ox0ADZ
{h Your e-mail server is no longer responding. However, you may be able to switch to a backup server and continue

working. To da this, you must close your mail file and re-open it.
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Tip #28: Clustering and Replication Settings

= Replication formulas are IGNORED by cluster replication

» All data is transferred regardless of replication formulas
» Data that “should not” be replicated will be removed by standard replication

tuspl :)
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Tip #29: Enable Cluster Commands (Even Without

= To use some “documented” features of a cluster task
» Set config CLUSTER_ADMIN_ON=1

= A server DOES NOT have to be in a cluster for this
to work!

MSoftware e Szooa
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Tip #30: Cluster Commands: Creating Database

= You can copy a database from one server to another using the
server console command

» CL copy serverAlldbl.nsf serverB!!db2.nsf
= Creates a non-replica copy
» Using various parameters
= CL copy serverAlldbl.nsf serverB!!db2.nsf REPLICA creates a replica

= CL copy serverAlldbl.nsf serverB!!db2.nsf TEMPLATE
creates a design-only copy

= CL copy db1.nsf db2.nsf creates a copy on the same server

= Works with or without a cluster defined — but — must have enabled
CLUSTER_ADMIN_ON

tuspl :)
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Tip #31: Policies

= Administrator wants to push down a NOTES.INI setting to all clients

= Or settings for the current location document
» The key here is that it will change the “current location”

= By modifying the desktop settings form, you can add/change any
notes.ini or location setting you wish!

» Caution: Requires a developer!

= Full instructions can be found in the Admin help database

tuspl :)
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Tip #32: Checking Policies on Clients

= Want to check what policies have been applied to the client locally?

» Open the users’ local address book
» Hold CTRL + SHIFT and choose View = Goto from the menu
» Open the $Policies view

= For more information on policies and troubleshooting, go here:
» www.pmooney.net/blogsphe.nsf/d6plinks/PMOY-6M326]#comments

tuspl :)
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Tip #33: Mail Settings with Policies

= Configure and use Mail policies wisely!

= Don't restrict all features to be changed by users

» Users don’t appreciate mail preferences being forced on them!
= Example: Letterhead

= Enable the Mail disclaimer feature

» Separate mail disclaimers per policy!
= Different departments could require different disclaimers
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Tip #34: View Indexes and Performance

= View index rebuild directory

» Directory used by update/updall tasks for rebuilding indexes
» Usually the windows TEMP directory

= Set path — separate array/disk if you can

» View_ReBuild_Dir=f:\views
» Huge performance boost

tuspl :)
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Tip #35: Port Compression

= Enable network port compression!

= This is especially good for server-to-server communication
» Must be enabled on both sides

- Up tO 600/0 CompreSSIOn Of data '_Port Setup for server/mooney m_‘

Communication ports

LANDtepip

LAN1 Rename... |
LANZ
L&N3 D_elete |

!-’f"t“.f v Reorder i}| &I

Selected port
Driver. TCP

[V Port enabled
™ Encrypt network data

CPIP Options... |
Garcol |
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Tip #36: Server Performance and Security Settings

= To aid performance, avoid using wildcards (*) in the Server security
settings (Server document)

Server Access Who can -

Access server: V users listed in all trusted directories

and

"LocalDomainServers
Sametime Development/Lotus Notes Companion Products

Bill S Buchan/HADSL =)

Mot access server: "$Terminated 2=

Create databases & "LocalDomainAdmins
templates: LocalDomainServers ;=]

Create new replicas: "LocalDomainAdmins
LocalDomainServers 4 v

Create master templates: "LocalDomainAdmins
LocalDomainServers 4 v

Allowed to use maonitors: "LocalDomainAdmins
LocalDomainServers 4 v

Mot allowed to use monitors: ~ $Terminated 2=

Trusted servers: "LocalDomainServers 2=
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Tip #37: Checking Server Connectivity Tool

= JPING

» Trace testing for Domino servers

» www-10.lotus.com/ldd/sandbox.nsf/ecc552f1ab6e46e4852568a90055c4cd/
222294a30361b72888256aa20083873e?0OpenDocument&Highlight=0,connect

= Always very useful to test ports and DNS
» Similar to traceroute and ping for Domino!
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Tip #38: Anti-Virus Software on Domino Servers

OS platform AV software

Exclude your TMP directory
Exclude your data directory
Exclude your Txn directory

v v v Vv

Exclude your view rebuild directory

These folders constantly change

Performance of your server can be hampered by the OS AV software

Use Domino AV software for the Domino engine

» Alternate your AV products between the platform and
Domino engine!
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Tip #39: Performance and Transactional Logging

= Transactional Log files should NOT run on the same RAID array as
the data drive

= Separate disks

» Local if possible (Raid 1)

» If on a Storage Area Network (SAN), use local drives for the Txn logs/view
rebuild directory

tuspl :)
MSoftware e Szooa

Friday 25 January 2008 48




Tip #40: Performance Enhancement

= ND_Go Faster=1
> Myth ...

» Does not do anything
= But sometimes it makes administrators feel better ...

tuspl :)
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Tip #41: Quick Access to Server Console

= The issues:

» Need quick console access?
» Want console access to the server from the Notes client?
» Don't want to/can’t load the Admin client?

= The simple fix: Add a button to your toolbar!

tuspl :)
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Tip #41: Quick Access to Server Console (cont.)

= To add a button to your toolbar:

Select File > Preferences - Toolbar Preferences
Click Customize

Click New - Button

Click Commands & Functions

Select Commands

Select AdminRemoteConsole

Give the button a name

Choose an icon

Save the button to your toolbar

v VvV VvV VvV VvV VvV VvV Vv v
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Tip #42: Diagnostic Collection

= You can configure the diagnostic collection feature on servers
» Crash information is sent to a mail-in database!

= Build the fault reports database
» Set as mail-in database

= All .nsd and console.log information will be mailed to the database

» Fault Analyzer in ND7
» Collates and displays information relevant to the crash(es)

tuspl :)
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Tip #43: Troubleshooting

* You can also configure the diagnostic collection feature on clients!

» Set in the Location document on the client
» Can be forced via policy

= Client crash information mailed to you!
» No need to ask the dreaded end user!
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Tip #44: Collecting All Database Information from
the Catalog

D atabase

= CATALOG.NSF database records all

database information that has the e e
following fields checked in btow dsniokig
data base propertles v E:tt ;:;:i:tsabase Catalog

¥ Show in 'Open Database' dialog
Include in multi-database indexing
Do not mark modified documents as unread
Mark parent note on reply or forward

Inheritance

v Inherit design from master template
Template name StdMNotesCatalog
Template version is 7.0 [04/05/2005)

Refresh desigh on admin server only
Database file is a master template
Template name

Multilingual Optiohs
Multilingual database
Default language
Default region
Default sort order
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Tip #44: Collecting All Database Information from
the Catalog (cont.

= In fact ... the catalog.nsf holds ALL database and template
information!

= Hold down CTRL + SHIFT when opening a database
= Select $ReplicalD view
= All databases/templates listed

» (O Domain Indexer Stat
» Regardless of the db property checked Firemsa;';t;‘mzxer e
» Very, very useful for audits Othar Views

($DbCategories)
($DocumentContent)
($DomainRepository)
($FileSystems)
($LDAPHier)
($MultiDbindex)
($ReplicalD)
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Tip #45: Fixing Bookmark.nsf Corruption

= In the case of local design element corruption, you don't always have to
delete bookmark.nsf!

» For example, users get errors when opening databases from the server
» Removing the cache and bookmarks resolves it
» It really annoys users!

= Open the bookmark.nsf database

= Hold CTRL + SHIFT and click View Go To

» Select (ByURL) view
» Select all the documents
» Delete them
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Tip #46: Fixing Replication Issues

= Inconsistent document counts in replicas is an issue!
» ACL seems perfect and readers’ fields are not a problem

= Sure-fire fix

» Clear replication history to force replication check at a document level

» Clear the replication cutoff date as well

Replication Options for Paul Mooney [ X] Replication History

E ) Basics
Date/Time &

\gl Send Set scheduled replication priority for this replica ~— Low (& Medium O High 3:;32;333; 1 :1 :1;

ﬁé} Other This replica includes deletion stubs for all documents deleted since 03/10/41986 21:37:32
&3 Advanced parniz2007 12204

[C] CD-ROM publishing date

I

@ Space Savers [ Temporarily disable replication for this replica

Changes made here apply to all locations Cancel

Friday 25 January 2008

Action Server & Filename

Receive” server/mooney mail\pmooney. nsf

Send server/mooney mailspmooney. nsf
Receive Paul Mooney/mooney names.nsf

Never received  server/mooney mail\pmooneydotnet. nsf



Tip #47: Pre-Populating Default ACL Entries in

= Set default ACLs for all databases based on templates

» Add the entries into the template contained in [ ]

} A” entrles Contalned FI\ccess Control List to: Mail (R7) mi‘
will be populated to =
=) Basics

data ba SeS bU I It frOm g People, Servers, Groups Im User type IW'
the templates Defaul: [Maroger =]

# LocalDomaingdming
og Advanesd [0 LocalDomainServers G
[&nonymous]
[-Default-]
[LocalD omainddmins]

=
o
0
@
“
“

Delete documents

A [LocalDomainServers)
[0 [OtherDomainServers)

QAJAAAATA !

IV Replicate or copy documents

Roles

Add... Rename... Remove
Effective Access...

Full name: [LocalDomainddmins]

An Access Control List [(ACL) defines who can view and edit your database.
Select a name in the list to see or set the access assigned to the name.

Last change: Lotus Notes Template Development on
According to: Lotus Notes Cancel

m software

Friday 25 January 2008 58




Tip #48: Cross-Certification

= Cross-certification is most often done incorrectly
» Cross certification is used to make two separate organizations (NOT domains)
communicate by exchanging certificate information
= Be careful what you accept

» Typically, you only need to accept the server certificate for communication

» Accepting the certifier certificate allows everyone in the external organization to
authenticate
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Tip #48: Cross-Certification (cont.)

| Issue Cross Certificate [ X

||
W ro n g Certifier... I server/mooney
> USIng O level key Server... | server/mooney

Subject hame | /BEGroup v I

Subject alternate names ’

Public key identifier 119w TXCHS JJSGM MTGCS NEGYS W3486
Expiration date 08208/201 616:23:35

. Lross certify ¢ Cancel |

= Right

» Using server-specific key

lissue Cross Certificate [ X

Certifier... I server/mooney
Server... | server/mooney

BECORPEDIO01 /Servers/Corporate/BE Group

Subject alternate names ’

Public: key identifier I P74R XHM2Y YWESN F5FSS RXE2G 734D5

Expiration date 03/08/2016 16:23:35

MSoftware
Cocel |
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Tip #49: Secure Ports

= By default, all ports for tasks in Domino are enabled
» LDAP, POP3, IMAP, HTTP, etc.

= By loading the task that supports one of these ports, the port is
instantly active

» Could happen by accident

= Disable the ports in the Server documents for tasks you do not use

Web l Directory | Mail I DIIOP I Remote Debug Manager I Server Controller I

TCPIIP part number: 7143 110, r25

725,
"Enabled 4=
"Na 4= NI,

TCPIIP port status: "Disabled =] "Disabled ;=] "Disabled ;=]

Enforce server access "Yes a= IJYBS_JLI
settings:

SSL port number: 7993, "ggs5 , T465

.
465
SSL port status: "Disabled =] "Disabled =] "Disabled ;=]

"Disabled ;=]

MNOTE: This server uses Internet Site documents to configure SSL settings and Authentication options for each protocol.

o _a M ~
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Tip #50: Update Server Access

= Changes made to server access fields in server documents are not
applied without a server restart — but can you force it?

» L UPDALL NAMES -R -T ($ServerAccess)

= Adding a user to a group for database access can take up to five
minutes to take effect

» Reset according to your requirements manually with ...
= sh NLcache reset
» Or, change the refresh time using the ini setting ...
* Nlcache_update_suppress_time=6000
= Where time is the number of nanoseconds, e.g., 6000 = 60 seconds
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Tip #50: Update Server Access (cont.)

= Note that the Notes client caches the access level and doesn't let go
until the client establishes a new session

» Have the client issue an F5 command to lock the user ID

= When user enters his/her password, he/she will have established a new
session
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Tip #51: Restricting Port Access

= It is possible to restrict user access to Domino servers over specific
ports

» Create a group in the Domino directory
» Place the ini variable Allow_Access_TCPIP="groupname” in the server’s notes.ini

= Excellent for controlling access to servers

» Example: Configure an extra port for the server
= Allow administrators to have access to that port
= You can STOP PORT PUBLICPORT and still give administrators access
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Tip #52: Restricting Server Access

= Prevent users from accessing server until reboot

» Server_Restricted=1
» No new user sessions permitted
» Restart of server returns value to 0

= Prevent users from accessing server
» Server_Restricted=2

= Useful when trying to get users off the server!
» E.g., scheduled downtime for upgrade
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Tip #53: Remove .mdm Files

= Old modem (.mdm) files still exist on servers in the MDM directory
= Remove the files unless you need them

= Possible security risk

» Cell phone connected to port at back of server
» Simple .mdm file used to accept connections
» Port-enabled — admin guy unaware ...
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Tip #54: Secure the ID Files of Your Servers

= The ID files for servers are usually created without a password
» If captured, this can compromise security

= Place a password on the server.id file

» Restart server command does not require password to be entered — the
password is cached

» Automatic fault recovery does not require password
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Tip #55: Protecting Certifier IDs

= Single password on a certifier is not enough

= Place multiple passwords on the ID file
» Too many times I have seen the password set to “lotusnotes”

= Alternatively implement and use the CA process
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Tip #56: ECLs

= Set up and use Execution Control Lists (ECL)
» This manages the execution of “untrusted” code on the clients

= Tie this in with a default signer ID file
» Administrators deploy applications and updates — not developers!

= Use Security settings policies to push ECLs out to clients
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Tip #57: Backups

= It's not enough to perform backups
» Test them for recovery

= When data has been lost, most people hope to rely on backups to
restore the data

» But countless times, the backups contain fresh air!
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Tip #58: Build Control

= Be sure you know the exact builds of your servers and clients

= Do not push new builds of a server into your domain without
adequate testing

» Not even a point release!

= Ensure system templates are tested fully
» Check your customized templates!
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Tip #59: Release Notes

= The release notes are one of the best sources of information for
administrators

» They help keep you up to date with the latest updates to the client/server builds

= Try to spend time reading the release notes on each iteration of the
product set

» It does not take too long — so, do try!
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Tip #60: Unread Marks in Replica Databases

Sometimes ... just sometimes ... go out of sync ...

» If you need to sync the unread marks
» Hidden tool

Unstack the replicas on the workspace
Hold CTRL and select the two databases
Hold CTRL + SHIFT and select Edit > Unread Marks = Exchange Unread

Marks
External Links, .,
Unread Marks Mark Selected Read
Mark All Read
Mark Selected Unread
Mark All Unread
i o Scan Unread...
administrator adrninis
Scan Preferred...
oh test oh L
Exchange Unread Marks
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Tip #61: Use the Tools Available All the Time

Log analysis

Decommission server analysis

Cluster analysis

Agent log databases

All these tools exist in the Admin client

» Often forgotten or ignored
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Tip #62: ND8 Out of office

= Server requires to be running Domino 8 or higher

= Configuration document

» Router SMTP tab
» Advanced
» Controls

= Set Out of office type to Service
= Now controlled by the router
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Tip #63: ND8 Out of office list

= Easy way to see which users are running the OOO Service
» There is a column in the admin client!

Databases only v / Tools

Is Logged © Template & Space Used & | Out of Office &
No StdR8Mail 85.3%
No StdR8Mail 85.3%
No StdR8Mail 82.5%
11:18:45 No StdR8Mail 83.8%

= Or type in “Tell Router 0” on the console
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Tip #64: Inbox maintenance feature

= Excellent improvement on mail server performance
» Especially large mail farms

= Administration process controls the task
» Defaults to Saturday at 1am

= Configured in the server document
» Administration Process section

= Choosing users

» From the server document
» OR from a mail policy setting
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Tip #65: Database Icon management

= Get familiar with database redirects!
» Moving a database Multi-Database Index...

» Deleting a database Zi";::ed Properties...
» Just create Redirect tool Move.
= Very simple to use from the admin client 2‘:’;};&%"
= You can point different people to different ;up
| uster...
SEIVELS: Delete...
= These WILL become a part of your Analyze..

everyday admin life Endtm:t

Manage Yiews...

Create Redirect...
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Tip #66: Prevent simple searching

= Simple searching hurts a domino server Database
» Searches a database that does not have an FTI

Unread Mark Options
» CPU intensive Don't maintain unread marks
: : Replicate unread marks:
= You can prevent simple searching now * Never  Clustered servers onlp
. Advanced Options
- Data ba se p ro pe rtl es Optimize document table map

Don't overwrite free space
Maintain Lastdccessed property
Disable transaction logaing

Use LZ1 compression for attachments

Don't allow headline monitoring

Allow more fields in database

Support Response Thread History

Don't allow simple search

Allow compression of database design

Allow soft deletions

Permanently delete documents after 48 hours
Limit entries in $UpdatedBy fields 1
Limit entries in $Revisions fields 0
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Thank you!

Paul Mooney / Blue Wave Technology

moone mooney.net

pmooney.net

Friday 25 January 2008 80



mailto:mooney@pmooney.net
mailto:mooney@pmooney.net

